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1 Introduction 

Thank you for purchasing an AIM XTRA flight computer! The AIM XTRA is a fully integrated 
GPS flight control, simulation, tracking and data recording computer. By using the AIM BASE 
receiver connected to a laptop, a full telemetry and tracking system is available. The AIM XTRA 
is fully USB compliant and is a plug-n-play device. 
 
Please download the AIM XTRA/BASE software from an Authorized Service Center (see 
section 7.2) to access all the features of your flight computer. 

1.1 Computing Requirements 

1.1.1 Minimum Requirements 

Computer: 

 Windows XP/Vista/7/8 

 3D Graphics Accelerator supporting DirectX 9 

 Screen Resolution 1024x768 pixels 

 512 Megabytes RAM 

 50 Megabytes free disk space 

 One 1.1 (or higher) USB port 

 Google Earth (free version) 
Note that Apple products are currently not supported. 
 
Accessories: 

 One USB Cable with a male Type A (Standard) and a male Mini-B Type connector 

 One three meter (nine foot) or longer USB Cable with a female Type A and a male 
Type A connector (optional but preferred for BASE unit operation) 

 Two button wheel/rollerball mouse (optional but preferred for the manipulation of 
graphs) 

1.2 The System 

1.2.1 Hardware 

AIM XTRA: This is a GPS flight computer with a Radio Frequency (RF) transceiver. 
AIM BASE: A radio transceiver which connects to your laptop. 
Helical Antennas: Two supplied for use with the AIM XTRA. 
Quarter Wave Antenna: One is supplied for use with the AIM BASE but may be used on the 
AIM XTRA. Extra quarter wave antennas may be acquired from your closest Authorized Service 
Center (see section 7.2). 
 
Note: The antennas should only be hand tightened when attaching them to AIM XTRA/BASE 
units. Do not use a wrench to attach the antennas! 

1.2.2 Firmware 

This is the software that runs on the device (AIM XTRA/BASE) which is preloaded. Updates 
may be downloaded and installed by the user from the internet. 
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1.2.3 Computer Software 

AIM XTRA: Is used to test, configure, download, view flight data, and simulate flights with the 
AIM XTRA hardware. 
AIM BASE: Is used to monitor and collect live flight data sent from the AIM XTRA via the AIM 
BASE hardware. 

1.3 Supported Versions 

This manual supports all version 2 releases of the AIM XTRA/BASE system. It is recommended 
that you always use the correct manual for your hardware and firmware version. If your 
hardware or firmware is of an earlier version, diagrams among other items may differ. If a new 
firmware version is available when shipping, it will generally be preloaded, but the associated 
changes may not be reflected in the preprinted manual. 

1.3.1 Manual Supports AIM XTRA Versions 

 Hardware v2.00, v2.01, v2.03, v2.04 

 Firmware v2.04, v2.05, v2.06, v2.08, v2.10, v2.11 

 Software v2.05, v2.06, v2.07, v2.08, v2.10, v2.11 

1.3.2 Manual Supports AIM BASE Versions 

 Hardware v2.00, v2.01 

 Firmware v2.00, v2.01, v2.02 

 Software v2.02, v2.03, v2.04, v2.10, v2.11 

1.4 System Features 

1.4.1 Features Inventory 

Hardware 

 100% USB connectivity - no drivers needed! 

 Swiss engineered aeronautical GPS (uBlox MAX-8Q) 

 50 mW 432 MHz up to 435 MHz band digitally synthesized transceiver 

 1.5 ppm TCXO for ultra-narrow band long range operation 

 100,000 foot barometric sensor 

 105g linear accelerometer 

 16g triple axis accelerometer 

 2000 degree/second triple axis gyroscope 

 Triple axis magnetometer 

 Four MB non-volatile flash memory (enough for hours of data) 

 Up to four 40 amp (continuous) outputs (software selectable) 

 Up to four auxiliary inputs (software selectable) 

 On-board temperature sensor 

 High sample rates (~100/s) 

 Antennas included - no need for expensive Yagi antennas 
 One helical antenna included for the AIM XTRA 
 Two quarter wave antennas included for the AIM XTRA and AIM BASE 

 XTRA Dimensions: 109.6mm L x 30mm W x 15.25mm D (4.315"L x 1.181"W x 
0.6"D) without antennas, approximately 152.4mm (6”)L with the helical antenna, 
276.86mm (10.9”)L with the quarter wave antenna 



AIM XTRA/BASE v2.xx Manual Introduction 
 

3 

 BASE Dimensions: 80mm L x 40mm W x 20mm D (3.15"L x 1.575"W x 0.79"D) 
without the antenna, 254mm (10")L when the antenna is attached. 

 
Software 

 Free custom designed software for setting parameters, simulation, viewing and 
downloading data 

 Support for metric and imperial units 

 Ejection line settings 
 Apogee 
 Time 
 Accent altitude 
 Decent altitude 
 Peak velocity 
 Input 

 256 user selectable radio transmission channels 

 HAM Callsign support 

 GPS Position, Time, Satellites Locked, and Altitude 

 Graphical display of critical flight data over time including: 
 Altitude 
 Vertical Acceleration 
 Lateral (X & Y axes) Acceleration 
 Rotational Rate of Change (X, Y, & Z axes) 
 Magnetometer Rate of Change (X, Y, & Z axes) 
 Atmospheric Pressure 
 Temperature 
 Computer and Ejection Voltage Levels 
 Ejection and Input Line Voltage Levels 
 Received Signal Strength Indicator 
 Ejection Line Continuity 
 Launch Detect 
 Apogee Detect 
 Rocket Orientation during Flight 
 Google Earth integration for real time vehicle tracking and visual location 

 User specified data write and transmission rates for each sensor/line during pre-
launch, pre-apogee, post-apogee, and ground time intervals 

 Low voltage power source protection – critical for preventing LiPo battery damage 
 
Capabilities 

 Kalman filtered ejection using GPS, barometric sensor and two accelerometers - 
high altitude ejection! 

 For sealed altimeter bays user may disengage Barometric sensor from 
Kalman filter algorithm 

 Ejection upon ascent – useful for altitude competitions, boost glider 
separation, etc. 

 >30km (≈18 ¾ miles) line of sight range with AIM BASE receiver using provided 
antennas! 

 XTRA range with the short helical antenna is approximately 20km (12 ½ 
miles). 

 XTRA range with the quarter wave antenna is extended to approximately 
40km (25 miles). 
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 Use of Yagi antennas on the BASE will extend the range to over 100km (≈62 
miles)! 

 Complies with International Traffic in Arms Regulations (ITAR) Requirements which 
demands that commercial GPS units disable writing/transmission of data when the 
altitude exceeds 18 km (≈60,000 feet) and (inclusive) the velocity is in excess of 
1,900 km/h (≈1,200 mph) (i.e. no specific altitude restriction). 

 Maintains GPS lock up to approximately 10g with rapid lock reacquisition (e.g. a 
flight on an CTI O25,000 to over 30,000 feet (≈79g boost for 1.2 sec) lost and 
reacquired lock within 5.4 sec). 

 
Recommendations 

 Recommended battery: 3.7V or 7.4V 1000mAh LiPo which provides approximately 
five (5) hours of operation. Use of a separate battery for ejection activation is 
recommended based on your igniter/e-match requirements. 

 One three meter (nine foot) or longer USB Cable with a female Type A and a male 
Type A connector (facilitates AIM BASE operation). 

1.4.2 Release Changes 

1.4.2.1 Changes in Firmware v2.10 Software v2.10 Release 

 Increased the number of radio channels from 16 to 256 

 Added voice notification of flight events 

 Added rocket orientation graphics 

 Added staging detection to the software configuration for pyro activation 

 Added angle detection to the software configuration for pyro deactivation 

1.4.2.2 Changes in Firmware v2.07 Software v2.08 Release 

 Fixed prompt when out of date firmware is detected 

 Improved handling of pressure sensor 

1.4.2.3 Changes in Firmware v2.06 Software v2.07 Release 

 Added RF compensation to improve transceiver reception 

 Fixed misspellings 

1.4.2.4 Changes in Firmware v2.05 Software v2.06 Release 

 Fixed metric to imperial temperature conversion 

 Corrected use of Imperial units in Temperature and Pressure graphs 

 Corrected XTRA Vertical Acceleration graph label 

 Corrected spelling errors in Settings and Notes tabs 

 Reordered Open and Close buttons to standard configuration in Tools menu 

 Fixed Windows 8 USB Power shutdown issue 

 Fixed Low Temperature shutdown issue 

 Released updated manual 

1.4.2.5 Changes in Firmware v2.04 Software v2.05 Release 

 Fixed time based ejection setting (in order to ground test this setting emulations must be 
run in real-time). 

 Improved Windows 8.1 integration 
 Fixed XTRA/BASE software crashes which occasionally occurred if there was a long 

delay before receiving a USB packet. 

 Fixed Fahrenheit conversion 
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 Vastly improved GPS data usage for initial pressure calibration within the control loop 

 Reduced AIM BASE latency 

 Improved AIM BASE USB connection indicator 

 Added AIM BASE RF received data rate display 

 Added RF TCXO frequency offset between XTRA and BASE display 

 Added imperial unit conversions for temperature and pressure 

1.4.2.6 Changes in Firmware v2.03 Software v2.04 Release 

 Notes tab now includes useful flight information 

 Improved prevention of false launch detects 

 Improved support for imperial units 

1.4.2.7 Changes in Hardware 1.11 Firmware 1.20 Software 1.20 Release 

 The AIM XTRA v2.00 now includes the latest MAX7Q GPS module 

 Ultra-sensitive RF front end transceiver, offering a link budget of over 145 dB 

 Multiple radio channels for interference free operation 

 1.5 ppm TCXO for ultra-narrow band operation 

 Lower power requirements (< 150 mA peak) 

 Improved GPS sensitivity (better and faster fixes) 

 Operation from a single cell Lithium polymer battery (3.7 volt nominal) 

 Four (4) output lines capable of 40 amps 

 All output lines software reconfigurable as input lines 

 Now only 30mm wide! 
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2 Installation 

 
Figure 1: Standard Configuration 

2.1 Overview 

Typically the AIM XTRA is used for flight control, data recording, and vehicle tracking. For 
tracking, the user should set up a laptop or similar device capable of running Windows 
XP/Vista/7/8 with the AIM BASE on the launch field. 
 
In order to setup the AIM system you will need to download and install the AIM XTRA and BASE 
software (a single zip file which includes this manual). 
 
When the AIM XTRA is turned on it will faintly beep once (USB powered) or twice (battery 
powered). The first beep indicates power up and the second beep (if applicable) indicates 
successful completion of pre-launch checks. 
 
The AIM BASE is powered through the USB connection to your computer. When it is plugged in 
you will see a Red light activate which indicates that the AIM BASE is receiving power and is 
active. 

2.2 Basic Configuration 

2.2.1 Software Installation/Updates 

The AIM XTRA/BASE is not delivered with the computer software however it is available over 
the internet from our Authorized Service Centers (see section 7.2). Please go to the site and 
download the software (including updates) at your convenience. All the software/updates are 
contained within a zip file. Once downloaded you will need to extract all the files from the zip file 
and insert them into a directory of your choosing where the software will run and your flight data 

Ejection Computer 
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Igniter 
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will be stored. Once extracted you will need to go into the directory where the files are stored 
and find the following two files: “AIM BASE.exe” and “AIM XTRA.exe”. For each of these files 
you will need to do the following: 

1. Right Click on the file 
2. Select from the Menu one or more of the following: 

a. Send to Desktop (shortcut) 
b. Pin to Taskbar 
c. Pin to Start Menu 

3. Go to the location where you have placed the shortcut to start the application and verify 
that it starts. 

 
If you do not have Google Earth installed on your computer you will need to download and 
install it. Google Earth may be downloaded at: http://www.google.com/earth/explore/products/ 
Follow the instructions downloading and installing the free version onto your computer. 

2.2.2 Initial Connections 

AIM XTRA 
In order to configure the AIM XTRA you will need to start the AIM XTRA software and then 
connect the AIM XTRA to your computer/laptop. Please note that when you make this 
connection the AIM XTRA will be powered via the USB connection so you should not have the 
AIM XTRA Comp terminals powered with a battery. If the AIM XTRA is powered by a battery 
when you plug it into your computer’s USB port the AIM XTRA will be in a “waiting for launch 
state” and will not accept any configuration settings, download requests, updates, etc. that you 
may attempt to apply from your computer. 
 
The first time you connect the AIM XTRA to your computer, it might take some time to recognize 
the device. You may be asked to restart your computer, but this is not necessary and can be 
ignored. 
 
You will be able to tell that the AIM XTRA has successfully connected to the AIM XTRA 
software if the USB symbol in the Console section of the screen changes color from Red to 
Green (see bottom left circle in Figure 3). Additionally, you will hear the AIM XTRA beep once 
which indicates power up. 
 
Once connected and recognized a message will appear in the Console indicating successful 
initialization along with the firmware version (see leftmost circle in Figure 3). At this point the 
device can be tested, settings and satellite almanacs loaded and flight simulations run. 
 
AIM BASE 
In order to collect telemetry and track the AIM XTRA you will need to start the AIM BASE 
software and then connect the AIM BASE to your computer/laptop. Please note that when you 
make this connection the AIM BASE will be powered via the USB connection. No additional 
power source is required. 
 
The first time you connect the AIM BASE to your computer, it might take some time to recognize 
the device. You may be asked to restart your computer, but this is not necessary and can be 
ignored. 
 
You will be able to tell that the AIM BASE has successfully connected to the AIM BASE 
software if the USB symbol in the Console section of the screen changes color from Red to 
Green (see bottom left circle in Figure 4). Additionally, you will see a Red light come on within 
the AIM BASE case which indicates that it is receiving power. 

http://www.google.com/earth/explore/products/
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Once connected and recognized a message will appear in the Console indicating successful 
initialization along with the firmware version (see leftmost circle in Figure 4). At this point the 
device may be used to receive transmissions from the AIM XTRA. 

2.2.3 Firmware Updates 

Warning: Prior to updating the firmware any flight data on the AIM XTRA should be 
downloaded and saved. If not done this flight data will be lost during the firmware updating 
process. 
 
Firmware updates are included in the software updates you’ve downloaded from an Authorized 
Service Center (see sections 7.2 & 2.2.1). When the AIM XTRA software is started the software 
opens up on the Control Panel tab. Once you’ve successfully connected the AIM XTRA look for 
the Update firmware button in the Firmware update section. In order to perform the update, just 
select the Update firmware button (see Figure 9). During this process do not disconnect the 
AIM XTRA or you will corrupt the firmware on the device. Note that during the update progress 
is reported in the Console screen. Once the update is completed you should see a “Success” 
message (note you may need to scroll down the Console screen to fully see the progress and 
completion messages). 
 
Similarly, when starting the AIM BASE software it also opens in the Control Panel tab and also 
has a section labeled Firmware update. Select the Update firmware button to perform the 
firmware update (see Figure 4). During this process do not disconnect the AIM BASE or you will 
corrupt the firmware on the device. Note that during the update progress is reported in the 
Console screen. Once the update is completed you should see a “Success” message (note you 
may need to scroll down the Console screen to fully see the progress and completion 
messages). 

2.3 Battery Power 

Figure 1 shows the standard setup for the AIM XTRA device. The AIM XTRA features a dual 
power system, allowing you to have separate batteries for the flight computer and the ejections. 
This can be bypassed by simply connecting the two positive terminals together with a short wire. 
A single battery is not recommended unless you are not using ejections with the AIM XTRA, or 
you are using a battery with a high current discharge capability. The left pair of terminal blocks 
are for the computer and the adjacent pair for the pyro/ejection batteries. Note that the terminal 
blocks are designed to accept 18 gauge or smaller wires. 

2.3.1 Computer Battery 

The input voltage range for the AIM XTRA computer is from 3.5 volts to 8.4 volts inclusive. It is 
recommended that either a single cell LiPo, a two cell LiPo, or a two cell LiFePo4 battery be 
used as a power source. Because the AIM XTRA is designed to work with single cell LiPo 
batteries, it is not recommended to use 9 volt batteries. The AIM XTRA has to convert the 
excess voltage to heat, which could cause reliability issues. However, if there is a desire to run 
off of 9 volt batteries, a single high current LED (or ~22 Ohm resistor) in series with the positive 
terminal will provide enough of a voltage drop to ensure trouble free operation. The minimum 
capacity for the computer battery is 200 mAh (approximately one and a half hours of use). The 
recommended capacity is 1,000 mAh or larger. 
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2.3.2 Ejection Battery 

The ejection battery should be chosen appropriately based on your igniter/e-match current 
requirements. The ejection battery voltage should not exceed 10 volts. 

2.3.3 Single Battery 

A single battery can be used to power both the computer and for firing the ejections. This should 
only be done when the battery can supply enough current such that the voltage does not drop 
while the ejections are being fired. A high discharge LiPo battery is recommended. 

2.4 Igniters/e-Matches 

The four terminal block pairs on the right of the two power terminal block pairs may be used for 
igniters/e-matches. Wire your igniters/e-matches as shown in Figure 1. Please ensure that your 
igniters/e-matches do not draw more than 40 amps as an absolute maximum, and that they do 
not short out after being fired. If these precautions are not followed, the transistor switches 
might be damaged. Note that the terminal blocks are designed to accept 18 gauge or smaller 
wires. 

2.5 Board Placement 

There are four mounting holes that accept standard M3 sized bolts, with enough room for 
spacers. Because the board has components on both sides, it is recommended that spacers be 
used to create a gap between the board and the mounting plate. The board should be placed 
vertically (z axis – see Figure 1) inside the rocket, with the transmitting antenna either pointing 
upwards or downwards. The ideal alignment is for the antenna to face towards the tail of the 
rocket. If the antenna is facing upwards in your rocket, the firmware includes an auto-detection 
feature that will automatically correct the acceleration readings accounting for the inversion.  
 
Furthermore in order to obtain the most accurate readings from the altimeter you should adhere 
to the following recommendations: 

 The mounting plate material should be transparent to radio frequencies which 
eliminates the use of metal or carbon fiber materials. 

 The supports for the mounting plates should not be metallic in order to avoid GPS 
reception issues. 

 The AIM XTRA should be aligned with the vehicle’s z axis to provide the most 
accurate vertical acceleration readings. 

 The mounting plate should be positioned so that the AIM XTRA’s axis is centered on 
the vehicle’s Z axis in order to give the most accurate lateral acceleration and gyro 
rotational values. 

 The avionics bay containing the AIM XTRA should be transparent to radio 
frequencies (e.g., fiberglass, phenolic, etc.). 

 The AIM XTRA transceiver and GPS antennas should not be located near any RF 
oblique materials (e.g., carbon fiber, aluminum, etc.) or other sensitive circuitry. 

2.6 Static Port(s) 

Unless you choose not to use barometric sensor data for your flight make sure to include a 
static port(s) so that external pressures may be sensed by the device. 
 
During flight the pressure within the avionics bay must rapidly equalize with the external 
atmospheric pressure in order to provide an accurate altitude reading. As the volume of the 
avionics bay changes the volume of air flow required for pressure equalization changes 
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proportionally. Assuming that pressure equalization should occur within the same time period 
regardless of volume (in order to maintain reading accuracy) then the area of the hole(s) 
needed for pressure equalization must be directly proportional to the volume of the chamber 
where the altimeter is located. We have determined that the following equation accurately 
models the size of the static port hole(s) required for accurate barometric sensor readings 
assuming that the flow is not choked. The equation and its derivation may be found at: 
http://www.offwegorocketry.com/userfiles/file/Documents/Static%20Port%20Holes.pdf 
 
Figure 2 depicts the results of this equation for a single port based on AV Bay size and Mach 
velocity. Note that we recommend the use of three or four static ports so the sizes in the chart 

need to be converted to the number of ports you are using. 𝑑𝑛 =
𝑑1

√𝑛
 where n is the number of 

ports and d1 is the value from Figure 2. 
 

 
Figure 2 - Single Port Size by Mach Velocity 

2.7 Data Transmission/Reception 

By default the AIM XTRA transceiver is configured not to transmit to allow it to be sold without 
requiring the purchaser to possess a radio license. Based on local laws you may be required to 
obtain a radio license in order to operate the AIM XTRA as a RF transmitting device. The user 
may activate/deactivate the transceiver by checking/unchecking the “RF Transmitter on” 
checkbox (see rightmost circle in Figure 3). Once the RF transceiver is activated you should 
also enter your HAM Call Sign so that your transmissions are prefixed with this designator as 
required by the communications agencies of many countries for amateur radio communications. 
 
When settings are changed in the XTRA software they are not automatically saved to the AIM 
XTRA unit. Once you have adjusted the settings to the desired values you must select the 
“Write Settings” button in order to have them saved to the AIM XTRA unit. The Console will 
indicate if your settings have been written successfully to the AIM XTRA unit. 

http://www.offwegorocketry.com/userfiles/file/Documents/Static%20Port%20Holes.pdf
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Figure 3: Turning on the RF Transmitter 

2.7.1 Channel Selection 

The channel allows you to choose from a set of unique channels for your radio link (see Table 
1). Only transmissions matching the channel set in the AIM BASE software will be received (see 
rightmost circle in Figure 4). You can change the transmission channel for the AIM XTRA on the 
settings tab (see rightmost circle in Figure 3). 
 

Channel Frequency (MHz) 

0 432.0000 

1 432.0125 

2 432.0250 

3 432.0375 

4 432.0500 

5 432.0625 

6 432.0750 

7 432.0875 

8 432.1000 

9 432.1125 

10 432.1250 

11 432.1375 

12 432.1500 

13 432.1625 

14 432.1750 

15 432.1875 

16 432.2000 

⁞ ⁞ 

256 435.0000 
Table 1: Channel/Frequency Map 
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Figure 4: AIM BASE Control Panel 

2.7.2 Data Rate 

You can change the rate at which data is transmitted to the AIM BASE (future implementation). 
Lower data rates increase the reliability of your transmission. If you change this setting on the 
AIM XTRA, you also have to select the same data rate on the AIM BASE software. 
 
The AIM BASE Control Panel tab and Console both contain RF status sections (see rectangle 
boxes in Figure 4). In these sections the transmission data rate is displayed in bits per sec (bps) 
along with Frequency error (difference between transmitter and receiver frequencies) in hertz 
(Hz) and a Recent packet graphic which is Green if a data packet is received gradually turning 
to Red over time if data packets are not received. Provided the Frequency error is between -400 
Hz and 400 Hz you should not have any reception issues. 

2.7.3 Reception 

For the best reception the AIM BASE should be raised as high as possible off the ground. The 
recommended minimum height above the ground is 3 meters (9 feet). The AIM BASE 
supporting structure should not be made out of a RF oblique material and the AIM BASE 
antenna should not be adjacent to the structure but rather projecting above it. A USB extension 
cable can be used to connect the AIM BASE to your computer in the field. 

2.8 External Inputs 

All four ejection lines can be used as input lines if configured as such in the AIM XTRA software 
(see Figure 5). Simply connect the positive sensor output to the negative terminal on the 
appropriate AIM XTRA line and the negative sensor output to either the Comp or Pyro 
negative terminal. The inputs are protected against over-voltage (maximum of 12 volts), but 
will only display values from 0 up to ≈3.3 volts. If your input is not within this range, you can use 
a resistive potential divider. Inputs cannot be negative as this will damage the device. Again, 
note that these terminal blocks are designed to accept 18 gauge or smaller wires. 
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Figure 5: XTRA Ejection Line Settings 
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3 Preparing for Launch 

3.1 Configuration 

In order to configure the AIM XTRA for flight you will need to connect it to your computer 
running the AIM XTRA software as described in section 2.2.2. Similarly you will need to do the 
same when configuring the AIM BASE. Note that if an item is greyed out it is unavailable in the 
current system configuration or the feature is unavailable at this time. 

3.1.1 XTRA Tools Menu 

The Settings menu item under the Tools Menu is used to select the GPS coordinates format 
and the unit system displayed within the XTRA application (see pop-up window in Figure 6). The 
options are to display GPS coordinates in one of the following formats: decimal degrees; 
degrees, minutes, seconds; or degrees and decimal minutes (default). The unit options are 
either metric or imperial. 
 

 
Figure 6: Settings Pop-up Window 

3.1.2 XTRA Settings Tab 

This area of the interface is where all the AIM XTRA settings may be viewed and adjusted (see 
Figure 7). Whenever the AIM XTRA unit is connected to the AIM XTRA software the unit’s 
current settings are read and stored into the software. There are three buttons at the bottom of 
the Settings tab: Read Settings, Write Settings, and Reset Settings. Read Settings will read 
the configuration of the AIM XTRA unit and adjust the software to reflect those values. If you 
make any changes to the settings in the software they will not take effect until you select the 
Write Settings button which stores the configuration on to the AIM XTRA unit. Finally the Reset 
Settings button resets the AIM XTRA unit to the factory settings. The Console will reflect the 
status of the Read, Write, and Reset processes. 
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Figure 7: XTRA General Settings 

3.1.2.1 General 

There are four sections within this tab: Power, Kalman filter, Transmitter and Flash memory (see 
Figure 7). 
 
Power Section 
The Power section is used to control battery usage and contains two check boxes: 

 Low voltage cut-off after landing – when checked monitors the computer battery and 
shuts the altimeter off when the cut-off voltage is reached. 

 Auto shutdown after landing – when checked shuts the altimeter off upon landing 
 
The spinner control labeled Cut-off voltage allows you to set the voltage at which the altimeter 
will shut down provided that the Low voltage cut-off after landing is checked. Note that this 
setting should be used to protect your LiPo batteries. The recommended settings are as follows: 

 For a 7.4v LiPo – 6.0v or higher 

 For a 3.7v LiPo - 3.5v (the voltage must not fall below 3.4v for the altimeter to operate 
so to preserve the data collected and allowing for a margin of error this value is the 
minimum permitted) 

 
Allowing a LiPo battery to discharge below 3.0v per cell will damage the battery so when using 
LiPo’s use of the cut off voltage controls is strongly recommended. 
 
Kalman Filter Section 
This section is used to control altimeter computations and is comprised of two check boxes: 

 Ignore pressure sensor on ascent – if checked the barometric sensor data is not used 
in the computation of variables such as altitude during ascent. This setting is used if your 
avionics bay is totally enclosed during ascent (e.g., no static ports). 

 Ignore pressure sensor on descent – if checked the barometric sensor data is not 
used in the computation of variables such as altitude during descent. This setting is used 
if your avionics bay is totally enclosed during descent (e.g., no static ports). 

 



AIM XTRA/BASE v2.xx Manual Preparing for Launch 
 

16 

Transmitter Section 
This section is used to configure RF transmissions and is comprised of two checkboxes: RF 
Transmitter on and Gate by GPS Lock. If RF Transmitter on is checked the unit will transmit 
the data it is capturing. If Gate by GPS Lock is check the unit will reduce the transmission 
power until GPS lock is obtained. This is used to minimize RF interference with the GPS 
antenna in order to expedite the GPS locking process while on the pad. In addition, there is a 
text box entitled HAM Callsign. The text placed in this box is sent with each transmission in 
order to be compliant with communication agency requirements. This is where you would enter 
your unique identification code provided to you by your local government agency for amateur 
radio communications. The Channel spinner control allows you to select the channel you wish 
to use for your transmission. Acceptable values are 0 to 256 (see Table 1). The Data Rate 
spinner control is currently unavailable but will be used to specify the rate at which data is 
transmitted from the XTRA to the BASE unit. 
 
Flash Memory Section 
This section is to control data recording and is comprised of one checkbox: Write to flash. 
When checked all data collected by the altimeter is stored in flash memory. If you do not check 
this box no data will be stored internally in memory, hence, no data will be able to be viewed or 
downloaded from the altimeter. 

3.1.2.2 Ejection Lines 

Under this tab are sets of spinner controls used to configure each output/input line. Since the 
options for all four lines are identical we will only cover one set of these controls (see Figure 5). 
 
The Mode spinner control consists of the following seven options: 

 Disabled – When selected the line is non-functional. All other spinner controls are 
unavailable. 

 Input – When selected the line is configured to accept data from an external source via 
the associated negative terminal. The acceptable voltage range is between 0v and 3.3v. 
Negative voltages will damage the unit. All other spinner controls are unavailable. 

 Time – When selected the line will act as an output line and fire the specified amount of 
time after launch. When selected the following spinner controls are also available: Time, 
On Time and Time Delay. 

 Peak velocity – When selected the line will act as an output line and fire when the 
velocity of the rocket begins to decrease after launch. This will occur near or after motor 
burnout so is used for staging or air starting. When selected the following spinner 
controls are also available: Stage, Max Angle, On Time, and Time Delay. 

 Climb altitude - When selected the line will act as an output line and fire when the 
altitude of the rocket reaches the specified altitude prior to apogee. This can be used to 
eject a boost glider or ejecting parachutes at a specific altitude in competitions. When 
selected the following spinner controls are also available: Altitude, On Time and Time 
Delay. 

 Apogee – When selected the line will act as an output line and fire when the rocket 
reaches apogee. Typically, this setting is used to eject a drogue chute in dual deploy or 
main parachutes in single deploy recovery systems. When selected the following spinner 
controls are also available: On Time and Time Delay. 

 Altitude after apogee - When selected the line will act as an output line and fire when the 
altitude of the rocket reaches the specified altitude following apogee. Typically, this 
setting is used to eject a main parachute in dual deploy recovery systems. When 
selected the following spinner controls are also available: Altitude, On Time and Time 
Delay. 
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The Time spinner is used to set a time following the launch at which the output line will activate. 
 
The Altitude spinner specifies the above ground level (AGL) altitude (metric units only) at which 
the output line will activate. Note that whether this occurs before or after apogee is dependent 
upon the Mode spinner. 
 
The Stage spinner specifies the position in the ignition sequence under which the pyro channel 
is active. For example, setting the spinner to 2 (default) activates the pyro channel after the first 
motor burn and may be used for a second stage or an air start ignition. In this example the pyro 
channel will no longer be active once the second motor burn is completed. 
 
The Max Angle spinner specifies the maximum angle from vertical under which the pyro 
channel is active. The default value is 180° so if you are using the pyro channel to initiate a 
staging event (e.g., motor ignition) then the setting should be reduced to an angle deemed safe 
for your launch considering the rocket design and area (0° is considered vertical so the setting is 
often in the range of 5° to 10°). 
 
The On Time spinner specifies the duration for which the output line is active. Unless testing of 
your igniters/e-matches has demonstrated otherwise it is recommended that a setting of two 
seconds or longer be used. Note that since a long time duration may be specified this setting 
can be used to operate motors, servos or other devices. 
 
The Time Delay spinner specifies the amount of time to wait after the Mode spinner setting has 
been reached before activating the output line. 

3.1.2.3 Sampling Intervals 

This tab is broken up into two sections: Flash write intervals and RF Transmit priorities (see 
Figure 8). 
 

 
Figure 8: XTRA Sampling Intervals Settings 
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Flash Write Intervals Section 
This section is divided into two subsections: Core write intervals and Write multiples. 
 
Core Write Intervals Subsection 
This subsection consists of 15 drop down list boxes each of which specifies the frequency in 
milliseconds at which sensor data is written to flash memory for the following data items: GPS 
position, Vertical acceleration (Z axis), Lateral acceleration (X & Y axes), Gyro (X, Y & Z axes), 
Magnetometer (X, Y & Z axes), Pressure, Temp, Ejection battery voltage, Computer battery 
voltage, GPS time, Status (output line continuity), Line A input (and output) voltage, Line B input 
(and output) voltage, Line C input (and output) voltage, Line D input (and output) voltage, and 
Orientation. 
 
Write Multiples Subsection 
This subsection consists of four spinner controls each of which specifies a multiplicative factor 
used to compute how frequently sensor data is written to flash memory in each of the following 
states: Pad (Pre-launch), Pre-apogee, Post-apogee, and Ground (Landing). The spinner values 
consist of non-negative integers. While the rocket is in each of the spinner control states the 
value of the control is multiplied times the sensor value in the Core Write Intervals subsection. 
The resulting number is the frequency at which the sensor data is written. For example if 
Vertical acceleration is set to 10ms and Pad is set to 10 then while the rocket is on the Pad this 
data is written once every 100ms (10ms*10), if Pre-apogee is set to 1 then the data is written 
once every 10ms after launch to apogee, if Post-apogee is set to 5 then the data is written once 
every 50ms after apogee to landing, and if Ground is set to 0 then the data is not written at all 
after landing. 
 
Note that given the Core Write Interval and the Write Multiples settings the amount of data that 
can be stored in flash memory is specified for each state in terms of time. 
 
RF Transmit Priorities Section 
This section consists of 15 spinner controls each of which specifies the priority in which sensor 
data is transmitted to the BASE unit for the following data items: GPS position, Vertical 
acceleration (Z axis), Lateral acceleration (X & Y axes), Gyro (X, Y & Z axes), Magnetometer (X, 
Y & Z axes), Pressure, Temp, Ejection battery voltage, Computer battery voltage, GPS time, 
Status (output line continuity), Line A input (and output) voltage, Line B input (and output) 
voltage, Line C input (and output) voltage, Line D input (and output) voltage, and Orientation. 
The highest priority is 1 which implies that the data will be sent the most often followed by 2, 
then 3, etc. Zero means that the data will not be transmitted to the BASE unit. The actual 
frequency of transmission will depend on computational activity, signal strength, and data rates 
(when implemented) among other factors. 

3.2 Operation Verification 

Please ensure that you have fully tested the AIM XTRA and also its integration into your rocket. 
Although all units are fully tested before shipping, it is essential that you test all aspects of the 
device, especially the ability to supply enough current to the igniters/e-matches. You should also 
ensure that all settings are correct, even if you didn’t change them yourself. Please also ensure 
that the radio link to the AIM BASE is working as expected. You should be able to achieve a link 
with both antennas disconnected when the devices are placed within a meter or so (few feet) of 
each other (when activated). 
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3.2.1 XTRA Control Panel Tab 

The Control/Diagnostic section in this tab consists of five subsections three of which are used to 
verify altimeter operations: High current output lines, Calibration, and Emulation (see Figure 9). 
 

 
Figure 9: XTRA Control Panel 

In the High current output lines subsection there is a button for each of the AIM XTRA output 
lines. When the AIM XTRA is connected to your computer these buttons are active and may be 
selected to test your pyro battery and igniters/e-matches. Just connect an igniter/e-match to the 
line(s) you want to test along with your pyro battery to the AIM XTRA then select the button for 
the line you want to test. When selected the igniter/e-match should fire if the battery has the 
power to initiate ignition. Warning: Igniters/e-matches generate significant amounts of heat and 
should be placed on non-flammable surfaces when tested. They should never be placed on the 
AIM XTRA unit during testing. 
 
The Calibration subsection is used to adjust the altitude readings from the barometric sensor 
data. The altimeter uses Standard Atmospheric table data combined with the barometric sensor 
data to compute its altitude. Since atmospheric pressure varies not only with altitude but also 
with temperature as well as low and high pressure weather fronts the altitude specification from 
the barometric sensor may vary from day to day (or within the same day) as temperature 
changes and weather fronts move through an area. Therefore, the Approximate ground 
altitude spinner control may be used to set the altitude (if you know what it is) or you may select 
the From GPS button to fill the spinner control with the current GPS altitude (you will receive a 
warning message if the GPS altitude is not within an internally specified accuracy range – e.g., 
no GPS lock). When the spinner control contains the value you desire (metric units only) select 
the Calibrate pressure altitude button to set the interpretation of the current barometric sensor 
data to the ground altitude. In order to improve correlation between the barometric sensor and 
GPS data it is recommended that you perform this calibration each day prior to launch. 
 
The Emulation subsection allows you to test the operation of the AIM XTRA under simulated 
flight conditions. Any previous AIM XTRA flight may be used in the emulation provided that the 
flight has been exported into a *.csv file. When the AIM XTRA is connected to your computer 
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the Emulate launch… button is active. Once selected a pop up window appears which allows 
you to select csv file to use for the emulation. Once you have selected the emulation file another 
pop up window appears requesting you to specify a file name and location to save the results of 
your emulation (also in csv format). Finally, a pop up window will appear which asks whether 
you would like to perform a real time emulation or not: 

 Real time: emulation is run in normal time for accurate testing of pyro line firing, etc. 

 Non-real time: the emulation is accelerated (useful if you just need emulation data). 
 
Once you make your real time selection the emulation will begin. While the emulation is running 
you will receive progress messages in the AIM XTRA console. If you desire to discontinue the 
emulation prior to completion the Stop emulation button is active and may be selected. Once 
completed you may look at your emulation results file to assess the AIM XTRA operation. 
Additionally, during the emulation if any the ejection charges were connected they should have 
fired. Warning: Igniters/e-matches generate significant amounts of heat and should be placed 
on non-flammable surfaces when tested. They should never be placed on the AIM XTRA unit 
during testing. 

3.2.2 Basic System Test 

Prior to checking the telemetry link you should validate operation of the AIM XTRA. 

3.2.2.1 AIM XTRA 

Run the AIM XTRA software and connect the AIM XTRA hardware to your computer (note that 
the Comp battery should not be connected or turned off). Verify that the XTRA is configured as 
you have set it (the values are read from the AIM XTRA when it is attached to your computer). 
Once verified select the Live Data tab (see Figure 10). Under this tab are five subtabs each of 
which depicts graphs of different AIM XTRA sensor data. When examining the data in each 
graph you should move/rotate the device to see the values changing. The AIM XTRA is marked 
with X, Y (perpendicular to the board), and Z axes to assist in this verification (see Figure 1). It 
is imperative that all sensor data is checked as sensor failure will result in incorrect operation. 
 

 
Figure 10: Altitude & Acceleration Live Data 
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Altitude & Acceleration Subtab 
The two graphs available on this tab are MSL Altitude and Acceleration. The MSL altitude 
shows the altitude above sea level (meters or feet) while the Acceleration graph depicts the 
accelerations along the X, Y, and Z axes in G’s (see Figure 10). Note that absolute acceleration 
data is reported for the Z axis which means that earth’s gravity is included. This means that the 
readings will be approximately 1 g higher than acceleration values relative to the earth’s 
surface. 
 
Gyro & Magneto Subtab 
The two graphs available on this tab are Gyro and Magneto. The Gyro graph depicts rotations 
around the X, Y, and Z axes in degrees/sec while the Magneto graph portrays the magnetic field 
variations around the X, Y and Z axes measured in Tesla’s (see Figure 11). 
 

 
Figure 11: Gyro & Magneto Live Data 

Inputs & Power Subtab 
The two graphs available on this tab are Inputs and Battery Voltages. The Inputs graph shows 
the voltage values of each of the four input/output lines while the Battery Voltages graph 
describes the voltages for the Computer and the Ejection batteries (see Figure 12). 
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Figure 12: Inputs & Power Live Data 

Pressure & Temperature Subtab 
The two graphs available on this tab are Temperature and Pressure (see Figure 13). The 
Temperature graph represents the measured temperature (in degrees C or F) while the 
Pressure graphs displays the barometric pressure (in kPa or inHg). 
 

 
Figure 13: Pressure & Temperature Live Data 

GPS Subtab 
This subtab is different in that it presents a number of specific data values (see Figure 14): 

 GPS Time: Time reported by the GPS satellites 

 Satellites used in solution: The number of satellites detected by the AIM XTRA 
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 GPS fix: Type of GPS solution available which should be “3D solution” 

 Lat: The AIM XTRA’s current latitude 

 Long: The AIM XTRA’s current longitude 

 MSL Altitude: The AIM XTRA’s current altitude 
 

 
Figure 14: GPS Live Data 

Below these values an image of the Earth will appear (the software automatically connects to 
Google Earth) if you are connected to the internet or have previously loaded a Google Earth file 
for your location (Google Earth must be loaded on your computer to support this function see 
section 2.2.1). Otherwise, an X/Y graph will appear with the X axis aligned with east and west 
while the Y axis will be aligned with north and south. Along the right side of the image is a 
vertical Green bar which graphically depicts the quality of the GPS satellite locks. Finally, there 
is a Focus on target button which when selected zooms the image onto The AIM XTRA’s 
current location (see Figure 15). 
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Figure 15: GPS Focused on Target 

A push pin marks the current position of the AIM XTRA on the map while a Red line 
marks the flight path and a line marks the projection of the flight path over the ground. 

3.2.2.2 AIM BASE 

Start the AIM BASE software, connect the quarter wave antenna to the AIM BASE, and then 
connect the AIM BASE receiver to your computer/laptop. You will be able to tell that the AIM 
BASE has successfully connected to the AIM BASE software if the USB symbol in the Console 
section of the screen changes color from Red to Green (see bottom left circle in Figure 4). 
Additionally, you will see a Red light come on within the AIM BASE case which indicates that it 
is receiving power. Additionally, a pop up window will appear asking for the name of a file and 
location to store the data collected from the AIM XTRA. Finally, make sure that the Channel 
setting is identical to the AIM XTRA Channel setting. The AIM BASE will not receive any data 
unless you have activated the AIM XTRA RF Transmitter (see section 3.1.2.1). 

3.2.2.3 AIM XTRA/BASE System 

To test that the AIM XTRA/BASE system is working together correctly connect one of the helical 
antennas and the main computer battery to the AIM XTRA (with no ejection explosives 
attached) then turn it on. The device will beep twice: once to indicate power up and the second 
time to indicate that it has run through its pre-launch checks (see section 4.1.3). In order to 
ensure that you lock onto a sufficient number of GPS satellites conduct this test with the AIM 
XTRA outside in the open free from obstructions. The AIM BASE should now be receiving a 
steady stream of data which will be displayed in the AIM BASE software. 
 
With two minor differences the AIM BASE graphs are identical to those described for the AIM 
XTRA (see section 3.2.2.1). The exceptions are in the Altitude & Vertical Acceleration and the 
RSSI & Lateral Acceleration tabs. 
 
Altitude & Vertical Acceleration Tab 
The Vertical Acceleration (Z) graph only depicts the Z axis acceleration (see Figure 16). Again, 
note that absolute acceleration data is reported for the Z axis which means that earth’s gravity is 
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included. This means that the readings will be approximately 1 g higher than acceleration values 
relative to the earth’s surface. 
 

 
Figure 16: BASE Altitude & Vertical Acceleration 

RSSI & Lateral Acceleration Tab 
This tab does not exist in the XTRA software. It contains two graphs (see Figure 17). The 
Lateral Acceleration (X/Y) graph is similar to the XTRA Acceleration graph except that it only 
depicts the X & Y accelerations. The Received Signal Strength Indicator (RSSI) graph has no 
corresponding equivalent in the XTRA software since it does not receive RF signals. The graph 
depicts the strength of the RF signal received in decibels (dBm). 
 
Look at the BASE graphs and move/rotate the XTRA to make sure that the received data is 
reasonable. The GPS location should also be accurate to within at least 20m (once more than 
four satellites are locked). 
 
Once you have confirmed that the BASE is operating as designed you can exit the BASE 
software application and disconnect the BASE unit from your computer. You can then turn off 
the XTRA unit and connect it to your computer. Once connected select the Download Data tab, 
then select the Download Flights button. When the flights are downloaded they appear in the 
flights section and you may now select the test in the Flights section. When you select a flight 
you have the option of loading the test data into the AIM XTRA software (see section 5.1). Once 
loaded, make sure all the data is reasonable. 
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Figure 17: BASE RSSI & Lateral Acceleration 

3.3 Achieving Faster GPS Lock 

To achieve faster GPS lock on the launch pad, a feature has been included to store available 
satellite data before going to the launch field. Although there is no range limit to this data it does 
degrade over time but will be valid for approximately one week. This data is called the satellite 
almanac. 
 
To pre-load the AIM XTRA with this data, you should connected it to your computer and place it 
where it has an unobstructed view of the sky (the more visibility the better). Once a 3D lock has 
been achieved, you should wait at least 15 minutes for all the almanac data to be downloaded 
from the GPS satellites. 
 
Now select the AIM XTRA Control Panel tab and look at the GPS section. You will notice four 
buttons (see Figure 9): 

 View stored almanac space vehicles: Reads the satellite almanac data from the 
software which can be viewed in the Console 

 Store current space vehicle almanacs: Stores the satellite almanac data in the 
software 

 Upload stored almanacs to GPS receiver: Stores the satellite almanac data in the AIM 
XTRA by overwriting any prior almanac data 

 Clear stored space vehicle data: Erases the almanac data from the software 
 
In order to store the satellite almanac data you should first select the Clear stored space 
vehicle data to remove any existing data and then select the Store current space vehicle 
almanacs button to save the satellite almanac data. 
 
On or just before the day of your flight connect the AIM XTRA to your computer and select the 
Upload stored almanacs to GPS receiver button in order to accelerate the GPS locking 
process. Again since this data is only valid for a few days this process should be performed as 
close to the launch date as possible. 
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Now, when the AIM XTRA is turned on, it will not need to download this data again and will 
achieve a much faster lock. Additionally, use of the Gate by GPS Lock in the XTRA Settings 
will also expedite GPS locking. It is still recommended to wait at least five minutes before 
launching, even if you have a good 3D lock. 

3.4 Graph Navigation 

3.4.1 Menu Navigation 

When viewing graphs from previous flights in the AIM XTRA software the Flight menu item is 
available and consists of the following submenu items: 

 Trim time… - A pop up window appears which allows you to enter the start time at 
which you want the view the graphs (useful for trimming off time while rocket is on the 
pad waiting for launch) to start and another pop up window appears which allows you to 
enter the end time of the graph (useful for trimming off the time after landing). Note that 
this action cannot be undone. 

 Zero time… - A pop up window appears which allows you specify a time you now want 
to consider as time zero (useful if you specify the launch time as zero). Note that this 
action cannot be undone. 

 Auto trim and zero – Combines the above two functions. 
 
Additionally, the Tools menu item is available and consists of the menu items: 

 Settings –allows you to change the GPS data format and the unit system for the 
displays (metric or imperial). 

 
When viewing graphs in the AIM BASE software the Tools menu item is available and consists 
of the menu items: 

 Clear and Zero - which will clear all the graphs and empty out their data. 

 Settings –allows you to change the GPS data format and the unit system for the 
displays (metric or imperial). 

 
The graphs in the AIM XTRA and BASE software all have the same options so the description 
of their operation is consolidated into this section. 
 
In each graph there is an Options menu which contains the following menu items: 

 Show Overview – Toggles on and off the high level view of the graph in the upper right 
corner. 

 Track Input – Moves the graphs so the last added point is displayed. 

 Zoom X – Zooms in on the X axis. May be selected multiple times. 

 Zoom Y - Zooms in on the Y axis. May be selected multiple times. 

 Fit – Adjusts the size of the graph to fit the available screen. 

 Optimize Axis – Calculates the X & Y axes extremes and then sizes the axes so that 
they are centered in the display. 

3.4.2 Mouse Navigation 

You may use your mouse to navigate around each graph in the following manner: 

 Left Mouse Button Down – Mouse image is a hand. When holding the mouse button 
down you grab the graph and may scroll it vertically/horizontally by moving the mouse. 

 Right Mouse Button Down – Mouse image is a hand. When holding the mouse button 
down you grab the graph and may scroll it vertically/horizontally by moving the mouse. 
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 Wheel/Rollerball - Mouse image is a hand. When moving forward the graph zooms in 
and when moving backward the graph zooms out. 
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4 Pre-Launch 

4.1 Normal Flight Operations 

4.1.1 Computer 

During field operations there are often distractions that take our focus away from launch 
activities. In order to avoid AIM XTRA/BASE system problems we strongly recommend that your 
computer Power Settings be adjusted so that your computer does not go into sleep mode. If 
your computer does go into this mode and the AIM XTRA or AIM BASE are connected to your 
computer they will lose power and shut down. 
 
If you are planning to use the GPS tracking capability and will not have internet access at the 
field there are two available options: 

1. Tether your computer to your smart phone to provide internet access (see your smart 
phone manual for instructions) or 

2. Pre-load a Google Earth file for your launch location. This is accomplished by opening 
Google Earth and then locating your launch site in the application. Once located put your 
computer in sleep mode and take it to the launch site. When you take your computer out 
of sleep mode Google Earth will retain the map of the launch location which will be 
accessed by the AIM XTRA/BASE software when running. Do not close the Google 
Earth application until you have completed your flight activities. 

4.1.2 AIM BASE 

If you are using the RF transmission capability start the AIM BASE software, go to the Control 
Panel tab then set the Channel to the Channel setting selected for the AIM XTRA when you 
prepared it for launch (see Figure 4). Attach the quarter wave antenna to the AIM BASE, raise 
the BASE on your support structure (see section 2.7.3) and then connect the AIM BASE to your 
laptop. You will not receive data until the AIM XTRA is activated. 
 
Note that in the Tools>Settings… item there are options for selection the presentation of GPS 
coordinates data as well as number system (Metric or Imperial) during BASE operations. In 
addition, there is a Voice checkbox. Select this checkbox if you would like to hear voice reports 
of the key events during your rocket’s flight.  

4.1.3 AIM XTRA 

Once the rocket is on the launch pad the device may be turned on as part of your normal launch 
preparation sequence. The device will produce two beeps: the first indicates that it has powered 
up successfully and the second that it has successfully completed its pre-launch checks. 
 
After power up the flight memory is scanned to locate the next free available memory region. If 
the device is full of previous flight data this can take a significant amount of time and delay GPS 
locking. It is therefore recommended to clear your device before launching (see section 3.3). 
Once the memory scan is complete the AIM XTRA will begin transmitting data to the AIM BASE 
if set to do so in the AIM XTRA settings dialog. The device will continuously monitor all its 
sensors while waiting for a launch detect condition. 
 
One distinctive feature of the AIM XTRA is that you can turn the device on while the rocket is 
horizontal. If you take advantage of this capability you simply have to ensure that the rocket is in 
its launch position for at least five (5) seconds before launching. This will allow the detection 
algorithm to correctly establish z-axis orientation. Again, to ensure that you are collecting valid 
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GPS data, it is recommended to wait at least five (5) minutes before launching, even if you have 
a good 3D lock. 
 
After activating the AIM XTRA if you are using its RF transmission capabilities validate that the 
AIM BASE is receiving data prior to launch. You should also validate that each of the output 
lines being used are depicted as Green (indicating continuity) above the BASE Console. 

4.1.4 Launch Detection 

The AIM XTRA uses an advanced Kalman filter approach for sensor fusion as well as a state 
machine to determine its current “state”. When in the launch detect state, the computed Kalman 
velocity will be monitored. If the velocity exceeds 30 m/s for 0.5 s, the state will change to boost. 
Please ensure that your rocket will exceed these parameters during launch. This method of 
launch detection is very robust, due to its use of all the necessary sensors of the AIM XTRA 
(including the GPS). However, violent shaking and rapid rotations could cause a false launch 
detect and should be avoided. 

4.2 Flight 

Assuming that the RF transmission capability is in use upon launch you can watch the real time 
data being displayed on any of the BASE graphs or the GPS position charted on the Google 
Earth map/graph (see Figure 18). Additionally, above the Console are Launch and Apogee 
blocks. When these states are detected by the AIM XTRA it is graphically indicated by changing 
the color of these blocks to Green. Similarly, there are continuity blocks for each output line. If 
these lines are in use and have continuity they are depicted in Green once activated they turn 
Red. 
 

 
Figure 18: BASE GPS View 

In addition, if you turn on your computer’s speakers (or connect your computer to a speaker 
system) you will hear audio reports of flight events. These include GPS Lock, Launch Detect, 
Coast (Motor Burnout), Apogee Detect, and periodic altitude data. 
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4.3 Retrieval 

If using the RF transmission capability the AIM BASE software should have recorded the GPS 
location of the rocket upon or just prior to landing. Assuming you have configured the XTRA to 
transmit data after landing you may still be receiving transmissions showing its current position. 
If you have an internet connection on the field or you preloaded the launch area map when you 
did have a connection the embedded Google Earth map will be shown with a marker depicting 
the location of your rocket. Otherwise, if you do not have an internet connection on the field and 
you did not preload a launch area map a graph will be displayed showing the landing distance 
from where you turned on the AIM XTRA. Regardless, the GPS coordinates will also be 
displayed. 
 
These coordinates can be entered into a GPS application on a smart phone or other GPS 
device in order to direct you right to your rocket if you do not want to take your computer with 
you during its retrieval. 
 
Once you have found your rocket, you should switch off the power. If the auto cut-offs are not 
configured the AIM XTRA will keep transmitting until it is turned off. Continued operation 
combined with the use of LiPo batteries will result in the batteries being damaged (LiPo 
batteries are damaged if their voltage drops too low). Even if the AIM XTRA cut-offs are 
configured a LiPo battery will eventually be damaged if you do not disconnect it from the circuit 
(manually or via a switch) since the AIM XTRA continues to draw a small amount of power in 
this state. 
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5 Post Launch 

5.1 Data Download 

Since the data collected by the AIM XTRA will be more detailed than that of the AIM BASE after 
you have retrieved your rocket you will want to download the data from the AIM XTRA onto your 
computer. Just start the AIM XTRA software and connect the AIM XTRA to your computer. 
Select the Download Data tab followed by the Download Flights button. Adjacent to this button 
is a blank horizontal bar marked 0%. After the button is selected the all the flights stored on the 
AIM XTRA will be downloaded to your computer. During the download process a green bar will 
appear and the percentage value will increase until all of the flights are downloaded (100%). 
Depending on the number and length of flights stored on the AIM XTRA this process may take a 
few minutes to complete (see Figure 19). 
 

 
Figure 19: XTRA Download Data 

Once downloaded you may select one of the flights listed in the Flights section to load into the 
AIM XTRA software. This is done by selecting a flight (which is highlighted along with the 
altitude preview graph being populated) and then selecting the Load selected flight button. A 
new tab (named Untitled* at the same level as the AIM XTRA tab) will be created containing all 
the flight data (graphs, settings, notes). By selecting this tab you will be able to view and 
manipulate the selected flight data (see Figure 20). In addition, you will have the following 
options under the File menu: 

 Save As – Allows you to save your data as an *.xtra file. Do this to retain your data for 
later viewing and analysis. The name you use for saving the file will now appear in the 
tab allowing you to identify which flight it contains. 

 Export to Excel… – Allows you to save your data as a CSV file. Save a copy of the data 
in this format if you intend to conduct customized analysis of your data. 

 Export emulation data… - Allows you to save your data as a CSV file. Save a copy of 
the data in this format if you intend to run emulations with this flight data. 
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Figure 20: Downloaded Flight 

If you wish to close this tab just right mouse on the tab and a Close menu item will appear. 
Selecting it will close the file without exiting the application. 
 
Once you have completed downloading data you may clear all the data from the AIM XTRA in 
preparation for future flights. This is done by selecting the Clear Device button. Once this action 
is taken the data is not recoverable from the device. 
 
Each data download will contain a new tab called Notes which is not available until the flight’s 
completion. This tab contains summary data of the flight along with a Flight Notes subsection 
where you may add any specific notes you have on the flight (see Figure 21). 
 
Once you’ve completed your download and are finished using the AIM XTRA/BASE applications 
you may shut them down by selecting the File menu followed by the Exit menu item. 
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Figure 21: AIM XTRA Notes Tab 

5.2 Data Analysis 

Sometime after your flight you may wish to examine the data. In order to view the data in the 
AIM XTRA software select the File menu followed by the Open menu item. Find and select the 
*.xtra data file to open it. The data will appear in its own tab which will be labeled with the name 
of the file. 
 
You can read exported data to Excel (or any other spreadsheet package) for further analysis 
(see Table 2). Combining the exported data with other available rocket data will allow you to 
compute a variety of useful information including but not limited motor impulse or drag 
coefficients. The possibilities are endless! Note that there are multiple time columns. Each time 
column applies to the columns to its right until another time column is reached. 
 

 

 
Table 2: Excel export data format 
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The AIM XTRA software also allows you to view your 3D flight path under the GPS tab using the 
GPS data. If desired you can alter the data used to draw the flight path to the Kalman filtered 
data by selecting the Kalman filtered altitude checkbox. Finally, you can export this flight path 
to a KML (Google Earth) file (see Figure 22) to share with others by selecting the Export 
Google Earth KML button. 
 

 
Figure 22: Google Earth Export 
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6 Important Notes & FAQs 

6.1 Disclaimer 

Due care has been employed in the design and construction of this product so as to minimize 
the dangers inherent in its use. As the installation, setup, preparation, maintenance, and use of 
this equipment is beyond the control of the manufacturer, the purchaser and user accept sole 
responsibility for the safe and proper use of this product. The principals, employees, and 
vendors of the manufacturer shall not be held liable for any damage or claims resulting from any 
application of this product. If the purchaser and user are not confident in their ability to use the 
product in a safe manner it should be returned to the point of purchase immediately. Any use of 
this product signifies acceptance of the above terms by the purchaser and user. 

6.2 Vital Details 

 Check that the settings on your device are correct before launching, even if you didn’t 
change them yourself. 

 Make sure that your battery is fully charged. We recommend single cell or two cell LiPo 
(1000 mAh) batteries. 

 Make sure your vent hole on the rocket is large enough to sense the air pressure as the 
rocket is launched and descends. 

 Seal the flight computer from the ejection bay/s to prevent damage from ejection gases 
and large spikes in the readings when the charges fire. 

 Make sure the device is switched off after your flight in case the charges have not yet 
fired, and to prevent battery drain. 

 Make sure that the altimeter can fire your type of charges, and that your charges are the 
correct size for your rocket. 

 There should be minimal metal near the AIM XTRA, and especially its antennas. 

 The AIM BASE should be as high off the ground as possible. We recommend a 
minimum of three meters. This is crucial for good signal reception! 

 There should be no metal near the AIM BASE. Please use a wooden/plastic pole to raise 
the AIM BASE off the ground. 

6.3 FAQs 

1) I have connected the AIM XTRA to my PC and nothing is happening. What’s 
wrong? 

The AIM XTRA does not need any special drivers, but you do need to download the 
software needed to interface with the hardware. You can find the software for your 
device on the Authorized Service Center websites (see section 7.2). Once downloaded, 
run the application. If your device still will not connect (a red USB logo will be displayed), 
please contact an Authorized Service Center (see section 7.2). 
 

2) My rocket has crashed – none of the parachutes were deployed! Help! 

Check that your parachutes were not too tight for your ejection charges. Also make sure 
that your ejections charges were not faulty, especially if they were assembled from a kit. 
It is usually very easy to determine when the AIM XTRA did indeed attempt to initiate the 
charges. If the unit is still intact, you can view the graph of the flight. The software 
indicates when the altimeter attempted to send current through the charges. You can 
also see if your parachutes might have gotten stuck, as there will usually be a noticeable 
pressure spike shown on the graph when charges have fired. 
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3) How do I connect a switch? 

Simply place a switch in-line with the plus wire. You can also use a switch to route both 
minus wires through (they are common). This will allow one switch to disconnect both 
batteries. Please remember to use a vibration-resistant switch! 
 

4) Does it matter which way around the AIM XTRA is placed? 

No. The AIM XTRA includes an auto-orientation detection algorithm. The default is with 
the RF antenna facing down. If your cone is transparent to RF, you could make the AIM 
XTRA antenna face upwards. 
 

5) Does the AIM XTRA support staging? 

Yes it can! There are dedicated settings for staging which you can access using the 
software provided (download from our website). The AIM XTRA can use the peak 
Kalman filtered velocity to determine when to ignite the specified charge. This is the best 
method and is preferred over time based delays. 
 

6) Is it possible to get custom software written for my device? 

We can do custom software without too much trouble. If it’s something we like, and think 
it will be used by others, we will attempt to incorporate it into the official product. Send us 
an email for more information (see section 7.2.2). 
 

7) Can Entacore develop custom software? 

Yes, we can. We have a range of capabilities from hardware design to software 
engineering. Contact us if you are interested in what we can offer you! 
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7 Warranty 

7.1 Limited Warranty 

7.1.1 Limited Warranty Coverage 

If your product does not work properly because of a defect in materials or workmanship, 
Entacore Electronics (“the warrantor”) will, for the period of one year, which starts with 
the date of original purchase (“warranty period”), at its option either (a) repair your 
product with new or refurbished parts, or (b) replace it with a new or refurbished 
product. The decision to repair or replace will be made by the warrantor. During the 
warranty period there will be no charge for parts or labor. You must carry-in or mail-in 
your product during the warranty period. This warranty only applies to products 
purchased and serviced in the United States. This warranty is extended only to the 
original purchaser of a new product which was not sold “as is”. A purchase receipt or 
other proof of the original purchase date is required for warranty service. For our 
international warranty policy, please email Entacore (see section 7.2.2). 

7.1.2 Carry-in or Mail-in Service 

For carry-in or mail-in service contact the Authorize Service Center supporting your geographic 
region (see section 7.2). 
 
This warranty ONLY COVERS failures due to defects in materials or workmanship, and DOES 
NOT COVER normal wear and tear or cosmetic damage. The warranty ALSO DOES NOT 
COVER damages which occurred in shipment, or failures which are caused by products not 
supplied by the warrantor, or failures which result from abnormal physical or electrical stress, 
abnormal environmental conditions, misuse, negligence, accident or rental use of the product, 
service by anyone other than a Factory Service center or other Authorized Servicer, damage 
that is attributable to acts of God, or is licensed for beta, evaluation, testing or demonstration 
purposes. 
 
THERE ARE NO EXPRESS WARRANTIES EXCEPT AS LISTED UNDER “LIMITED 
WARRANTY COVERAGE”. THE WARRANTOR IS NOT LIABLE FOR INCIDENTAL OR 
CONSEQUENTIAL DAMAGES RESULTING FROM THE USE OF THIS PRODUCT, OR 
ARISING OUT OF ANY BREACH OF THIS WARRANTY. (As examples, this excludes damages 
for lost time, travel to and from the servicer, loss of data or other memory content. The items 
listed are not exclusive, but are for illustration only.) ALL EXPRESS AND IMPLIED 
WARRANTIES, INCLUDING THE WARRANTY OF MERCHANTABILITY, ARE LIMITED TO 
THE PERIOD OF THE LIMITED WARRANTY. 
 
Some states do not allow the exclusion or limitation of incidental or consequential damages, or 
limitations on how long an implied warranty lasts, so the exclusions may not apply to you. This 
warranty gives you specific legal rights and you may also have other rights which vary from 
state to state. If a problem with this product develops during or after the warranty period, you 
may contact your dealer or Service center. If the problem is not handled to your satisfaction, 
then write to the warrantor’s Consumer Affairs Department at the addresses listed for the 
warrantor. 
 
PARTS AND SERVICE WHICH ARE NOT COVERED BY THIS LIMITED WARRANTY ARE 
YOUR RESPONSIBILITY. 
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7.2 Authorized Service Centers 

Please carefully pack and ship, prepaid and insured, to the Authorized Service Center. 

7.2.1 United States 

Off We Go Rocketry, LLC 
3600 France Ave S 
St Louis Park, MN 55416 
Tel: +1 952 201 3002 
Skype: gary.stroick 
Web Site: www.OffWeGoRocketry.com 
eMail: president@OffWeGoRocketry.com 
AIM Software Download: 
http://www.offwegorocketry.com/product_info.php?cPath=220&products_id=1203 

7.2.2 International/South Africa 

Entacore Electronics 
2 Muller Street 
Sutherland 
6920 
South Africa 
Tel: +27 72 466 8590 
Skype: dawie.debruyn 
Web Site: http://entacore.com 
eMail: info@entacore.com 
AIM Software Download: http://entacore.com/electronics/aimxtra 

http://www.offwegorocketry.com/
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http://entacore.com/
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